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Part 1 (Preparation) 
As homework, prior to the case discussion in class, get acquainted to the case.  The following resources are linked in this document as well as on the course Canvas module.
· Watch a video entitled Waking Sleeping Beauty to hear Anna’s personal account and how doctors at the Emory Sleep Center in Atlanta, GA found a treatment that finally helped her feel awake. 
· Read the Emory news article, “An antidote for hypersomnia”, by Baker and Eastman, published on Nov. 21, 2012 describing this treatment. 
· Read the abstract and introduction of the peer reviewed scientific article describing this work by Rye et al., 2012. 
These articles and video set the stage for the case. In order to understand how and why Anna woke up following the specific treatment given to her it will be helpful to learn a little about cellular communication in the brain, neurotransmitters, and their receptors (especially the ones involved in sleep). At the same time learning the vocabulary and key concepts of related to neurochemistry of sleep and sedatives will help in understanding the molecular basis for the cause and treatment of Anna’s sleep crises.
· Review these sub-sections and answer the questions below. 

A. Understanding sources

Based on the video you watched and articles you have read about this case answer the following questions. 

Q1 (2 pts). Describe in 1-2 sentences the main difference between the popular news report and the peer-reviewed scientific article.  (You can be more general about your answer regarding primary scientific literature and news sources.)






Q2 (2 pts). For the three sources of information that you viewed/read for this case list one benefit and one drawback in the table below.
	Source
	Benefit
	Drawback

	Video
	
	

	News report
	
	

	Journal article
	
	



Q3 (1 pt) . Define the prefixes Hypo- and Hyper- used in the description of this case in the peer-reviewed manuscript. Find at least one example where this meaning is used.




B. Cellular Communication in the Brain

Anna’s doctors guessed that there was something off balance between the excitation and inhibition systems in her brain, which might be causing her extreme sleepiness. To understand her condition, we must first understand normal cellular communication works in the brain and how it is inhibited in sleep.

Neurons are cells in the nervous system that transmit information to other nerve cells, muscle, or glands in the body to changes its physiology and elicit a response. Communication between neurons and other cells is carried out by small chemicals called neurotransmitters. The space between the 2 cells is called the Synapse. (see Figure 1). When a suitable electrical/chemical signal reaches end of the pre-synaptic cell it causes vesicles full of the neurotransmitter to be released into the synapse. Specific receptors on the surface of second (post-synaptic) cell binds it and sends a signal. 
[image: ]
Figure 1: Neuronal synapse showing a presynaptic cell, post synaptic cell, neurotransmitters, synaptic vesicles, and receptors

Q4 (2 pts). Match the names listed in column A with the Label numbers of Fig 1 (listed in column B). 

	Column A
	Column B

	Neurotransmitters
	4

	Synaptic vesicle
	

	Presynaptic cell
	

	Postsynaptic cell
	

	Receptors
	



· Review the vocabulary in Box 1 to learn more about signaling in the brain and answer the following questions
Box 1: Vocab
Neurotransmitters are small molecules derived from basic building blocks of life, e.g., amino acids. For example, gamma amino butyric acid (or GABA) is derived from the amino acid Glutamate by a decarboxylation reaction. They bind to proteins (such as receptors) and affect their functions. They are also referred to as ligands and may include naturally occurring molecules or man-made drugs.
Receptors are large transmembrane proteins that change shape when they bind to small molecules. Many clinically important drugs also bind to receptors in the brain to change our behavior, to treat diseases, and in special situations like inducing anesthesia for surgery.  
There are many different combinations of neurotransmitters and receptors in the nervous system that add together to control the types of physiological and behavioral responses that we can see in ourselves. Two main types of neurotransmitter receptors are listed here:
a. Metabotropic receptors control metabolic pathways inside the cell, which can change the activity and expression of proteins.
b. Ionotropic receptors open pores, or channels, to allow specific ions to cross the cell membrane. These “ion channels” alter the electrical properties of the membrane to increase or decrease the likelihood that the cell will continue the chain of communication by firing an action potential. 
Some neurotransmitters (e.g. glutamate) are excitatory (i.e., make it easier to fire action potentials while others (e.g., GABA) are inhibitory (i.e., make it harder to fire action potentials).
























Q5 (1 pt). Review Figure 1 and examine what happens to the receptors when the neurotransmitter binds. Does it open or close? What can you say about the type of neurotransmitter receptor shown in figure 1? 




There are additional 2-min videos on the Canvas site if you wish to review the concepts of membrane potential, action potential and the GABA A receptor.


C. Neurochemistry of Sleep

Normal brain function relies on a balance between inhibitory signaling mediated by the molecule GABA and excitatory signaling driven by Glutamate. Key players involved in inducing sleep are discussed here.  
· Neurotransmitter: The chemical GABA (gamma-amino butyric acid) is one of the main inhibitory chemicals of the nervous system. It dampens/slows down brain activity and promotes sleep. 
· Receptor: There are two main types of GABA receptors. GABA type A (GABA-A) receptors are ionotropic and GABA type B (GABA-B) receptors are metabotropic, but the overall response of both types of receptors is to inhibit the activity of the cell.   
· Structure and Function of GABA-A receptors:
· Structure: These receptors are pentameric, i.e., they are composed of 5 transmembrane protein subunits that together form a chloride ion-selective channel. Although there are many different isoforms of the protein, the most common type of GABA-A receptors found in the human brain are composed of 2 alpha (α), 2 beta (β), and 1 gamma (γ) subunit.
· Function: Binding of neurotransmitters triggers ion channels to open. When GABA binds to the GABA-A receptor, the ion channel is open and chloride ions can cross the cell membrane. Other ligands, including clinically important drugs, e.g. benzodiazepines (a sedative), anesthetics and depressants can also bind to the GABA-A receptor to alter its function by opening or closing the Cl− channel. A simple cartoon of the GABA-A receptor is shown in Figure 2 along with the binding sites of various ligands. 
[image: ]
Figure 2: GABA-A receptor, chloride (Cl−) ionophore complex. The cut-away view shows binding sites for a variety of compounds that influence the function of the receptor complex. (Adapted from Olsen, R.W. and DeLorey, T.M., (1996), GABA Receptor Physiology and Pharmacology, Basic Neurochemistry: Molecular, Cellular and Medical Aspects. 6th edition.)

· Key vocabulary often used in describing the binding of drugs and small molecules to their target receptors is included in Box 2.

Box 2: Vocab
Agonists: These are drugs or molecules that turn on the function of a protein. The natural ligand usually acts as an agonist.  
Antagonists: These are drugs or molecules that decrease or inhibit the function of a protein.
Allosteric modulators: The word root “allo” means “other”. These are drugs or molecules that bind at a location other than the natural ligand’s binding site. Modulators could be positive (increase activity of the protein) or negative (decrease its activity). 


· Based on what you have learned here answer the following questions.

Q6 (1 pt). The GABA-A receptor is a transmembrane protein. Where would you expect a chemical signal (GABA, Benzodiazepine etc.) to bind this receptor? Circle ONE and explain your choice.
a. extracellular side 
b. transmembrane domain 
c. intracellular side
d. in the central channel

Q7 (1 pt). Explain why you circled the answer in Q6 above.








Q8 (4 pt). Complete the following table describing the effect of ligand/ drug binding to the GABA-A receptor.
	#
	Ligand/Drug bound 
	Effect on Chloride channel
	Explain your answer

	1
	Agonist
	
	

	2
	Positive Allosteric Modulator
	
	

	3
	Antagonist
	
	

	4
	Antagonist as above + high concentration of GABA
	
	






Part 2: A Clue in Anna’s Spinal Fluid

Although we have all may have been sleep deprived at some point in time and can relate to how difficult it becomes to focus or carry out simple routine tasks, Anna Sumner’s case was different – she craved sleep and would not be able to wake up refreshed even after ~30 hours of sleep.

Before discussing Anna’s case any further let us review “Neurochemistry of Sleep” that you learned about in part C. of the Preparation section of this case. 

Review the structure and function of GABA-A receptors and some key vocabulary terms used in the case (Agonist, Antagonist, Allosteric modulators). The relevant sections to review are included below for your convenience. 

· Structure and Function of GABA-A receptors:
· Structure: These receptors are pentameric, i.e., they are composed of 5 transmembrane protein subunits that together form a chloride ion-selective channel. Although there are many different isoforms of the protein, the most common type of GABA-A receptors found in the human brain are composed of 2 alpha (α), 2 beta (β), and 1 gamma (γ) subunit.
· Function: Binding of neurotransmitters triggers ion channels to open. When GABA binds to the GABA-A receptor, the ion channel is open and chloride ions can cross the cell membrane. Other ligands, including clinically important drugs, e.g. benzodiazepines (a sedative), anesthetics and depressants can also bind to the GABA-A receptor to alter its function by opening or closing the Cl− channel. A simple cartoon of the GABA-A receptor is shown in Figure 2 along with the binding sites of various ligands. 
[image: ]
Figure 2: GABA-A receptor, chloride (Cl−) ionophore complex. The cut-away view shows binding sites for a variety of compounds that influence the function of the receptor complex. (Adapted from Olsen, R.W. and DeLorey, T.M., (1996), GABA Receptor Physiology and Pharmacology, Basic Neurochemistry: Molecular, Cellular and Medical Aspects. 6th edition.)

· Key vocabulary often used in describing the binding of drugs and small molecules to their target receptors is included in Box 2.

Box 2: Vocab
Agonists: These are drugs or molecules that turn on the function of a protein. The natural ligand usually acts as an agonist.  
Antagonists: These are drugs or molecules that decrease or inhibit the function of a protein.
Allosteric modulators: The word root “allo” means “other”. These are drugs or molecules that bind at a location other than the natural ligand’s binding site. Modulators could be positive (increase activity of the protein) or negative (decrease its activity). 


Back to Anna’s case - After excluding known causes of sleepiness, doctors stopped all stimulants and drugs that were being prescribed to Anna to collect a sample of her cerebrospinal fluid (CSF). The doctors were looking for clues about the unique pharmacology within her sleepy brain. Researcher scientists analyzed her sample along with 31 similarly hypersomnolent patients and found a substance that increased GABA-A receptor function in cultured cells! 
Let’s examine some key evidence that scientists gathered to help understand Anna’s case. 

Box 8: Experimental techniques
Ions, like Na+, K+, Ca2+, and Cl−, are present in different concentrations inside and outside neuronal cells leading to a membrane potential difference in charge. When channels are open, ions can move across cellular membranes according to the concentration and electrical gradients, leading to rapid and transient changes in distribution of these charged particles. Movement of ions is recorded as current and these electrical signals are transmitted through neurons to trigger physiological changes. 
Patch clamp is an experimental technique used to measure changes in electrical properties of cell membranes to determine whether or not the channels in these receptors are open or closed in the presence of different ligands.
When GABA-A receptor channels are closed there is a baseline reading. In these experiments, GABA and/or other GABA-A receptor agonists open the chloride channels to let negative ions (Cl−) into the cells. The patch clamp records this entry of Cl− ions as a downward deflection from the baseline. The larger the deflection (or dip) in the recording the more the Cl− ions have entered, inhibiting the neuron.  




















Scientists used patch clamp electrical recordings on a specific cell line with GABA-A receptors to measure currents triggered by the following:

	Trace 
	What was added
	Why was it added

	a
	10 μM GABA alone
	control to establish a baseline

	b
	Hypersomnolent patient CSF alone
	To see if the CSF factor can work alone

	c
	Hypersomnolent patient CSF + 10 μM GABA
	To see if the CSF factor impacts GABA binding and GABA-A receptor function

	d
	Flumazenil, a competitive antagonist + Hypersomnolent patient CSF + 10 μM GABA 
	To see if the CSF factor binds to the benzodiazepine binding site

	e
	Flumazenil, a competitive antagonist + 10 μM GABA
	Control to see that Flumazenil does not interfere with GABA binding

	f
	normal GABA concentrations in typical CSF
	Control after all pharmacological agents were washed away



Review the chloride currents seen for each of these cases and answer the following questions.
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Figure 3. Chloride currents recorded from HEK293 cells expressing human GABA-A receptor. Vertical axis (current) calibration bars equal 200 pA (picoAmps) and horizontal axis (time) calibration bars equal 5 s.

Q1 (2 pts). Compare the chloride current traces shown in b. and c. and explain the conclusion that can be drawn from your observation.








Q2 (2 pts). Compare the chloride current traces shown in c. and d. and explain the conclusion that can be drawn from your observation.   Hint: Also compare with trace a.




Q3 (1 pt). Based on the traces in Figure 3, which of the following statements is correct?  (Circle or highlight one.)
a. Only in trace c. the GABA-A receptor is open and Cl− ions are flowing into the cell
b. The substance in Anna’s CSF can bind to GABA-A receptor and open the Cl− channel 
c. The substance in Anna’s CSF needs GABA in order to open the Cl−channel 
d. Flumazenil can close the GABA-A receptor Cl− channels 
e. When the GABA-A receptor is open K+ ions are flowing out of the cell

Q4 (1 pt). Based on the results presented, speculate as to where in the GABA-A receptor do you think the CSF factor binds relative to other molecules binding to the receptor?  Briefly explain your answer.




Part 3. Molecular Basis of Sleep 

To better understand Anna’s story in molecular detail we need to understand the structure and function of the GABA-A receptor.

A. GABA- A Receptor Structure

In this section we will explore known structures of the GABA-A receptor to learn more about its shape and structure. The resource for accessing molecular structures of GABA-A receptors is the Protein Data Bank.

Box 3: Resource
RCSB Protein Data Bank (RCSB PDB, www.rcsb.org) provides access to 3D structural data of biological macromolecules (proteins, nucleic acids, carbohydrates and their various complexes). In addition, it provides information about the experiment used to derive the data, details about the molecules included in the experiment, and links to bioinformatics resources that can provide additional information about the protein/molecule of interest. Each structure in the PDB has a unique identifier called PDB ID. Atomic coordinates form the PDB can be explored and analyzed using various visualization software (e.g., Jmol, Pymol, UCSF Chimera, iCn3D).












· Search for “GABA-A receptor” in the PDB (www.rcsb.org) by typing in the protein name in the top search box. 
· In the ‘Refinements’ window on the left side of the screen, select Homo sapiens and scroll down and select 2015-2019 as the ‘Release date’.

Q1 (1 pt). How many structures of the GABA-A receptor did you find in the archive? Why are there so many structures?






[image: A screenshot of a computer

Description automatically generated]

Sometimes searches through RCSB are burdensome and yield many results to sift through.  You can also perform a search at NCBI.  Go to the NCBI website (), select structure () and enter ‘GABA-A receptor’ ().  Perform the search.  

Q2 (1 pt).  Using the NCBI Structure database, how many structures of the GABA-A receptor did you find in the archive?




Return to RCSB.org and search for PDB ID 6i53.
· Click on the PDB ID 6i53 to open the structure summary page for this entry. This is the structure of a human GABA-A receptor. Review Box 4 and answer the following questions.

Box 4: Navigating the Structure Summary Page
1. Title - that tells you what the structure is about
2. Snapshot - of what the structure of the molecule/complex looks like. 
3. Authors – who solved the structure
4. Literature –access the article that describes the structure. This section also includes links to PubMed page and the abstract of the article describing this structure, when available.
5. Macromolecules – All proteins and nucleic acids present in the structure are listed here. Each unique type of macromolecule or molecular chain is listed as a separate entity. There may be multiple copies of each molecule in the structure. 
6. Small molecules – All ligands, ions, cofactors, inhibitors that are present in the structure are listed here. You can find links here to explore the interaction of this ligand with the target protein.
7. Experimental details – describe details about how the structure was determined 
8. Structure quality – shows a slider that provides insights about the quality of the structure and its agreement with the experimental data and geometric standards.
See http://pdb101.rcsb.org/learn/guide-to-understanding-pdb-data/introduction for details




Q3 (1 pt).  Explore the structure summary page to learn about the contents of the structure and fill in the table.

	PDB ID
	6i53

	Author(s) of entry 
	

	Year when the structure was published/ released
	

	Structure determination method
	

	# of macromolecular entities    
	

	# of polymer chains
	

	Names of proteins in these chains (chain ID)
	

	# of different small molecule ligands in the structure and their identifiers
	



Q4 (1 pt). Why do some of the protein subunits list multiple chain IDs on the structure summary page? 





· Before you explore the structures of the GABA-A receptor any further, review Box 5.

Box 5: Vocab
Residues: Building blocks of biological macromolecules are sometimes referred to as residues. Depending on the context, this may refer to amino acids (frequent use) or a nucleotide (less common use).
Chains: The term chain is used to refer to covalently linked amino acids (polypeptide). Some proteins structures contain more than one polypeptide - each subunit of this structure is referred to as a chain. To help locate amino acids in the structure, each chain is given an identifier (called Chain ID) and each amino acid in the chain is assigned a number. 
Domains are conserved parts of a protein that can evolve, function, has a stable three-dimensional structure and often can stably fold and exist independently (of the full protein). On the other hand, loops and linker regions between domains are often flexible and cannot be clearly seen in experimental structures. Their atomic coordinates may be missing from the file because the large protein was cut into smaller pieces and only the relevant structures are included in the experiment OR they were present in the experiment, but its location could not be seen due to high mobility.

















Box 5: Continued
Complex assembly and stability: Protein complexes can be assembled in vitro (outside the cell) to study the structure. In order to stabilize the assembly additional ligands or even polymer chains may be included in the experiment – for example 
a. lipid-like or detergent molecules are included in membrane protein complexes to prevent them from aggregating or precipitating from the aqueous solutions 
b. antibodies, parts of antibodies, nanobodies, megabodies, or other stable proteins/domains may be included in the experiment to facilitate assembly formation, enhance solubility of the complex, or trap the molecule/complex in a specific conformation. 

· Click on the 3D View tab on the Structure summary page and view the molecular structure of the GABA-A receptor. 
· Interactively rotate and reorient the structure to get acquainted with it. 
· Spend a few minutes playing around with the different menus to see some of the different ways this protein view can be adjusted. 

RCSB now uses a program called Mol* to view the protein structure.  Instructions have been altered to use Mol* (apologies for any inconsistencies – please let me know).

In the 3D image, you should be able to see the window shown below.  
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· To gain orientation (there may be another way), highlight the Megabody (found outside the cell).  
· To do this, pull down the ‘Megabody’ selection from the ‘Sequence of’ window ().  This changes the selection to that structure.  The Megabody is found outside of the cell.
· If the ‘Residue’ row is now visible above the 3D image, click on the arrow ().
· Click on ‘Residue’ and pulldown ‘Entity’ ().
· Click on the ‘Megabody’ portion of the structure in the 3D image (you may have to rotate to identify the Megabody and click on structures.  Hint: the structure protrudes from the remainder of the Model.
· Click on the paintbrush () and select blue in the popup window and ‘Apply Theme’.
· Click off of the image (but somewhere in the window) to view the colored chain.



Q5 (1 pt). Using the extracellular Megabody, can you identify the extracellular ligand binding domains and transmembrane domains in the GABA-A receptor structure? Which type of secondary structural elements (helices or sheets) make up these domains? 


Using the steps leading into Q4, repeat the coloration using different colors for the subunits of the GABA A receptor.  Look back to your answer for Q2 to remind yourself how many different polypeptide chains are present.

[image: A screenshot of a computer
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To hide non-protein structures, click the ‘Show component’ icon (eyeball) in the toolbar on the right (8).  Click on both ‘Ligand’ and ‘Carbohydrate’.  
To label the subunits (with the letters corresponding to the chains, click on ‘Measurements (9) in the toolbar on the right, click ‘Label’ and then click on one of the subunits of the protein.   A letter (A-F) should appear.  Repeat this process until all six letters are present (you may need to rotate the image to view all six).  Hint: Rotating the image so that you can view from the intracellular surface may facilitate labeling all of the subunits.



Q6 (2 pt): Make an image with the extracellular domain on top. Make as many chain labels (A-F) visible in your image.  Download the image (there is a tool icon to the right of the 3D image that looks like a camera lens).  Label the extracellular domain, the transmembrane domain and the Megabody (F). Include the image below.







You can (and should) also download a ‘state’ of this image, which is an image that you can reload if you happen to need to reload.  When you download (Screenshot), scroll to the bottom and select ‘state’ and then ‘state’ again.  This will download a .molj file (you may wish to rename it to identify the structure or state of the structure).  You can come back and open this file at a later time if you wish.  In this same box, you will also find an ‘Open’ option.


To visualize the secondary structures, select ‘Chain’ in the toolbar above the image.  In the toolbar on the right, select ‘Component’ and to the right of ‘Polymer’ there will be … (click there).  Now select ‘Set coloring’ > ‘Residue property’ > ‘Secondary structure’.  Your image should show secondary structures for all of the subunits similarly.  
 
Q7 (2 pts). Describe the distribution of the secondary structural features in this image. Upload an image of your results.






 


Part 4. GABA-A Receptor Function

In this section we will explore the structure of GABA-A receptor with its natural ligand (GABA) bound to it. This will set the stage for understanding where the ligand binds and how it affects receptor function. 

Explore the structure of GABA-A receptor in complex with GABA (RCSB - PDB ID 6dw0) and view in 3D.  Rotate and explore the structure.

Note:  As you proceed through this (and other) Mol* explorations, you can save (use Camera icon) images as you proceed.  The .png extension are still images.  There is an option at the bottom of the camera window called State.  This allows you to save an image in .molj, which has be ability to be opened (same pathway) as a 3D image in Mol*.  Periodically, you might wish to save a 3D version (.molj) if you wish to come back to the exploration.

Q1 (1 pt).  Explore the structure summary page to learn about the contents of the structure and fill in the table.  Each of the structures has been deposited by different research groups – therefore, some of the subunit labeling is different.

	PDB ID
	6dw0

	Title
	

	Author(s) of entry 
	

	Year when the structure was published/ released
	

	Organism
	

	# of entities    
	

	# of polymer chains
	

	Small molecule (not carbohydrate)
	






Open the 3D image of the file.
In the top of the right hand toolbox, click structure and select Model.

· Color the polypeptide Entity with 3 different colors to distinguish the pentameric chains.
· Toggle (click arrow) to see the bar above the 3D image
· Select ‘Entity’ from the left hand pulldown (this selects all of the subunits of the same type)
· Click on the subunit(s) that you wish to color
· Click on the paintbrush, select a color and ‘Apply theme’
· Repeat for other ‘Entities’
· Label the pentameric subunits as done previously.
· Note: You may not be able to see all of the labels at the same time.  
· Hint: Try labeling the pentameric subunits from a bottom view and then reposition the 3D image to view from the side.
· In the toolbar above the image, select ‘Chain’ from the left hand pulldown
· Click to highlight the chain (subunit) that you wish to label
· In the right hand tools, click Measurements > Add > Label
· Save a copy of your image in two formats
· Using the Camera icon
Q2 (2 pts) Download a labeled image of the entire protein

Q3 (1 pt). Scrolling over each subunit, create a key to indicate which labels represent which subunits.
	Subunit (chain)
	Identity (Record the names of the subunits, not just the identifiers)

	A
	

	B
	

	C
	

	D
	

	E
	



Note:  It is important to understand that in some cases, multiple PDB files have been uploaded for the same (or similar) structure by different groups.  Each PDB file may have different subunit chain identifiers for the actual protein subunits.  Make sure that you understand the subunit identification for the PDB structure that you are visualizing.

Where are the GABA molecules binding?  There are three GABA molecules shown in the model (Entity ABU).  To more clearly view the GABA binding sites:
· In the Sequence window at the top of the image screen, select the gamma-amino-butanoic acid.  Click on the ABU (abbreviation for GABA).  
· To color, click Entity > paintbrush > yellow
· To make the GABA a space filling model
· Ligand (right hand toolbox) > … > Add representation > Space filling
· To label the ABU (GABA) molecules
· Chain (top toolbar) > Measurements (right hand toolbar) > Add > Label
· Repeat for all 3 GABA molecules
· Note: if you did this all at one time (Entity), the labeling will not be as descriptive.  
· Note: Chains that have been labeled can be unlabeled by hiding (eyeball icon) or Remove under the Labels section in the right hand menu.

Q4 (2 pts).  To which GABA-A receptor chains are the GABA molecules bound (between which subunits)?  Recalling the previous structure (or you can view on iCn3D), do you know if the GABA binding sites are intracellular or extracellular?  Include one or more images of your protein that has been labeled to support your answer.  



	GABA 
	Between chains (letter)
	Between Entities (record names)

	ABU401
	
	

	ABU407
	
	

	ABU408
	
	







Q5 (1 pt).  Visualizing the GABA A receptor from the outside of the cell (end on), provide an image of the protein with the subunits labeled as well as the GABA molecules.







Explore the binding environment of one of the GABA molecules as follows. 

Return to the Structure Summary page for PDB ID 6dw0.
Scroll down to the Small Molecules section.  In the model, there are three ABU (GABA) molecules indicated.  You can explore the chemical interactions of one of these GABA molecules by clicking on the Ligand Interaction button on the right hand side.  This takes you to ABU408 in the 3D model that you were previously looking at.


· To highlight the GABA molecule, click on the molecule (it will probably be highlighted from the previous page).
· To make this a space filling molecule, select the GABA, then go to Ligand > … > Add Representation > Spacefill.  
· While highlighted, make the GABA yellow (use the paintbrush tool).
· Label the GABA (Toggle the Menu bar above the 3D image on, select the GABA, go to Measurements (right hand toolbox) > +Add > Label)
· You now should have the GABA (ABU408) as a spacefilled molecule that is yellow and labeled.
· If non-covalent bonds are not evident (dashed lines), zoom out and then zoom back in on the molecule.  
· Go to Components > Preset > Options >Non-covalent interactions
· Turn on only Ionic (yellow dash) interactions
· Label the amino acids that interact with ABU408 (GABA)
· Make note of which protein subunits these amino acids interact.

The Option icon looks like [image: ].


Q6 (2 pts). List the names of 2 amino acids whose side chains for ionic bonds with GABA (ABU408) and identify which polypeptide chains these are from.  Include a picture to support your answer.




· Turn off the ionic bonds and show the hydrogen bonds.  
· Label the amino acids that interact with the GABA (ABU408) using hydrogen bonds.  You might wish to hide the labels on the amino acids that do not form H bonds but did form ionic bonds.

Q7 (2 pts).   List the names of 2 amino acids whose side chains form hydrogen bonds with GABA (ABU408) and identify which polypeptide (Entity) these are from.  Include a picture to support your answer.




 


Part 5. When you Take a Sedative …

The natural ligand GABA binds to the GABA-A receptor to produce an inhibitory effect by opening chloride channels. What do you think happens to these receptors when individuals who are unable to sleep, take a sedative like valium (a benzodiazepine)? In this section we will explore what happens to the GABA-A receptor when you take valium.

Open another structure in RCSB – GABA-A receptor in complex with GABA and Valium (PDB ID 6hup).  Valium is an example of a benzodiazepine. 

Scroll down in the Structure Summary to find Small Molecules

Q1 (3 pts).  Complete the table below:
: 
	Small molecule abbreviation
	Chains that it interacts with
	Complete chemical name
	Identify which complete chemical name indicates GABA and which is Valium

	
	
	
	

	
	
	
	

	
	
	
	



Q2 (1 pt).  Click on the Small molecule abbreviation for Valium and include the chemical structure below.







Return to the Structure Summary page for 6hup.  

· To the right of the Valium entry in the Small Molecules section, click on the Ligand Interaction button on the right hand side.  This will go to the 3D view (Mol*) focusing in on the ligand (valium) interacting with the protein structure.
· Using the Sequence window, pull down the Name of the Valium molecule in the list.  The abbreviation should show up where sequence information was before.
· Present the Valium
· In a space filling model – Select Valium representation > Ligand > … > Add representation > Spacefill
· Color the Valium orange (Select > Paintbrush > Orange)
· Label the Valium (Select > Measurements > Add > Label)
· This should be labeled as DZP502
· Label the amino acids that form chemical bonds with Valium at this location (there are 3 locations in the model).

Q3 (2 pts) What are the two amino acids, positions (numbers) and chains that react with this Valium?  Include an image of your labeled structure.






Where do the Valium molecules bind relative to the GABA molecule?

· Click on the toolbar icon Reset icon (looks like a recycle sign).  This should zoom outward from your model. 
· Click on Entity > subunit > paintbrush > gray.  
· Repeat for all 3 polypeptide subunits (alpha, beta and gamma)
· Identify the GABA molecules based on where you observed them in Part 4.
· Click on Chain > click on GABA and color each yellow
· There are three Valium molecules shown bound to this model.  Two are indicated/labeled as 502 and you just identified the binding sites for one of them in Question 3.
· Click on the two 502 molecules (located in a similar region of the structure) and color each orange.
· Identify the third Valium in the structure (binds in a different location and may not be functional).  Color that Valium purple.
· 


Q4 (2 pts). Where in the structure are the GABA and Valium molecules bound? Which GABA-A receptor chains are they bound to? Support your answer with a figure.






Box 2: Vocab (previously seen in Part 1)
Agonists: These are drugs or molecules that turn on the function of a protein. The natural ligand usually acts as an agonist.  
Antagonists: These are drugs or molecules that decrease or inhibit the function of a protein.
Allosteric modulators: The word root “allo” means “other”. These are drugs or molecules that bind at a location other than the natural ligand’s binding site. Modulators could be positive (increase activity of the protein) or negative (decrease its activity). 


Q5 (1 pts). Based on the location of valium bound in this structure what can you say about the nature of GABA and valium interaction (use the information in Box 2 to help with your description? 





 


Part 6: Waking up Anna 

The substance in Anna’s CSF was making her sleepy just like the action of benzodiazepine, so her doctors considered testing Flumazenil, a competitive inhibitor of benzodiazepine, to treat her. It worked and Anna woke up (for the first time in many years).  Explore the structure of the GABA-A receptor in complex with GABA and Flumazenil to understand where it binds and how it regulates the receptor function. 

· Open the file PDB ID 6d6t in RCSB and explore the structure. 

Q1 (2 pts). Scroll down in the Structure Summary to find Small Molecules and complete the table below.
	Small molecule abbreviation
	Chains that it interacts with
	Complete chemical name
	Identify which complete chemical name indicates GABA and which is Flumazenil

	
	
	
	

	
	
	
	

	
	
	
	

	
	
	
	



Q2 (1 pt).  Click on flumazenil and include a picture of the molecule below.





· From the Structure Summary page (RCSB), click on Ligand Interaction for flumazenil.
· Click on the arrow (right side toolbar) and then click on the flumazenil molecule to highlight.
· Make the flumazenil molecule space filling (Ligand > … > Add representation > spacefill)
· Color the flumazenil molecule light blue (cyan)

Q3 (1 pt).  Between what two polypeptides does the flumanezil bind?



Similarly to Part 5 of the worksheets, color all of the protein subunits gray and color the GABA molecules yellow.  If you wish, you can hide the antibody polypeptides from this structure and the carbohydrate small molecules.

Q4 (2 pts). Where in the structure are the GABA and Flumazenil molecules bound? Which GABA-A receptor chains are they bound to? Support your answer with a publishable figure drawn using Mol* (in RCSB).


 







Q5 (2 pts). Based on your explorations of these structures, can you explain the mechanism of Flumazenil’s action in waking up Anna (Hint: Think about what might be in the CSF.).






Q6 (2 pts) With a hand drawn model summarize the structure of the GABA-A receptor (as seen from the outside of the cell). You may use the pentameric structure shown below to draw and mark in the model where GABA, benzodiazepine, and Flumazenil bind. Remember to label the alpha, beta, and gamma chains of the GABA-A receptor.






 


Part 7: Beyond Waking Up
Access to adequate quantities of the drug presents a practical problem for Flumazenil to be considered as a cure for hypersomnia. Anna is the only one person in the world who has taken the drug for an extended period of time. Ongoing research is focused on learning more about Anna’s condition and figuring out alternative ways to treat it.
Q1 (2 pts). How would you design the next experiment to figure out if the mechanism that you are proposing can explain Anna’s recovery from hypersomnia (with Flumazenil treatment)? 





Q2 (2 pts). Briefly describe in 3-4 sentences what experiments you would do and why?
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